
Hardwareová konfigurácia PLC SIMATIC S7-300 DA :)
Hardvérová konfigurácia je nástroj na výber, nastavovanie parametrov a diagnostiku
komponentov  (položiek,  častí)  hardvéru  PLC  zostavy  umiestnenej  na  štande  alebo
výrobnej linke.

Je  veľmi  dôležité  dbať  na to,  aby sa jednotlivé komponenty,  ktoré umiestňujeme na konfiguračnú lištu v
programe, zhodovali so skutočným (reálne použitým) komponentom.

Podrobný postup hardvérovej konfigurácie PLC SIMATIC DA:

Po príchode na pracovisko v stanovenom poradí:

zapnúť zásuvku na pracovnom stole,●

zapnúť PLC,●

zapnúť PC SIMATIC FIELD PG (PG).●

Heslo PG je user

 fotografia
Panel PLC, resp. sieťový vypínač sa nachádza v ľavej časti

Pred začatím kurzu je nutné vymazať obsah Flash Card.

Ako vymazať Flash kartu?

Spustiť program Simatic Manager. Jeho zástupca sa nachádza na ploche PG.

Zástupca programu
SIMATIC Manager

Niekedy je treba zavrieť vytvorené projekty. Projekty sa obyčajne nachádzajú na ploche a vypnúť ich treba
myškou resp. klikom na X v ich pravom hornom rohu.

Krabička CPU315F by mala byť prepnutá na režim STOP.

Vybrať File > New a vytvoriť vlastný projekt na D:\skolenie CDV napríklad IKR_1_3_2021

V názve projektu nie je dovolené používať . (bodku)

Ak chcem vymazať pamäťovú Flash Card (SD kartu, MMC kartu) musím to urobiť v PG, to znamená, že ju musím
vybrať z PLC. Pred vybratím karty, musím preto PLC vypnúť. SD kartu potom vložím do PG. Slot na kartu sa
nachádza na pravej strane PG. Vkladá sa kontaktami zhora, karta ostane vyčnievať z PC. 

fotografia 
Zasunutá MMC karta a minitlačidlo slúžiace na vybratie MMC karty

V programe Simatic Manager zvoliť File > S7 Memory Card > Open

Uvidím obsah SD karty.

V programe Simatic Manager zvoliť File > S7 Memory Card > Delete

Program očakáva dvojnásobné potvrdenie, že dáta z karty chcem naozaj vymazať, t.j. klik YES, klik OK. Okno S7
memory card zavrite.

Po vymazaní karty, jej vybratí z PG a jej vložení do slotu PLC, PLC zapnem. 

Ďalej uvedené kroky (rozblikanie komponentov) slúžia na lokalizáciu (zistenie polohy) zariadení. Lokalizácia je
potrebná ak je na výrobnej linke linke viac kusov zariadení toho istého typu. 

V programe Simatic Manager zvoliť PLC > Edit Ethernet Node > Browse.
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Zjaví sa okno kde uvidím zariadenia (účastníkov) na sieti (k dispozícii sú 4)[1]. Niekedy to trvá dlhšie.

Postupne vyberám účastníkov, spustím a vypnem blikanie (Flash), t.j.

klik na Flash a po rozblikaní Stop Flash. 

Toto postupne opakujem 3krát, t.j. preverím spojenie s účastníkmi:

ET200S bliká => P1 a P2,●

CP 343-1 (CP-300 CP) bliká => X1P1 a X1P2,●

SCALANCE X-200 bliká => P1 až P8.●

Po kliku na OK vymažem IP adresu (IP address) a mená účastníkov (Device Name, skrátene Name) tak,           

že kliknem na Reset, ktorý nachádza v pravej spodnej časti okna.

Program očakáva dvojnásobné potvrdenie, že chcem zachovať iba MAC adresu.   

 
Nevymazané Device name t.j. Device name na zmazanie

Vymazané IP adresy a Device Name resp. Name účastníkov

Následne vkladám do nového projektu resp. jeho okna k MPI(1) zbernicu.

Po zvýraznení názvu projektu kliknem na Insert[2] > Subnet > Industrial Ethernet

K MPI(1) a k Ethernet(1) vkladám zbernicu SIMATIC 300 Station. 

MPI (Multi point interface) je základná (primárna) zbernica, ktorá je štandardnou súčasťou CPU.

Po kliku na pravé tlačidlo myši  na prázdne miesto plochy kliknem na Insert New Subnet > SIMATIC 300 Station

Po rozkliknutí[3] SIMATIC 300 Station sa objaví nápis Hardware
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Obrazovka po rozkliknutí Hardware

Po rozkliknutí Hardware vložím z menu (rady) SIMATIC 300 > postupne:

1.) koľajničky, t.j. RACK-300 > Rail

Pretiahnem symbol koľajničiek do veľkého horného okna.

2.) zdroj, PS-300 > PS307 5A > 6ES7 307-1EA01-0AA0

Pretiahnem symbol PS307 5A do koľajničiek, resp. do poľa označeného zelenou farbou.

3.)  CPU, CPU-300 > CPU 315F-2PN/DP > 6ES7 315-2FJ14-0AB0 > V3.2.  Verzia sa nachádza na alebo vo vnútri
krabičky.

Z ponuky vyberiem Ethernet (1) potvrdím OK

V X2 v malom hornom okne vyberiem PN-IO resp. Device Name  a premenujem na AB02 a potvrdím OK

Prostredníctvom Object Properties...

Slot 3 pri našej konfigurácii v DA vynechávame, pretože nie je potrebný. 

4.) Do slotu 4[4] vložím, t.j. vyberiem CP343-1, t.j. CP-300 > Industrial Ethernet  > CP343-1 > 6GK7 343-1EX30-0XE0 >
V2.4

Z ponuky vyberiem Ethernet (1) potvrdím OK

V X1 v malom hornom okne vyberiem PN-IO resp. Device Name a premenujem na AB03 a potvrdím OK

Dá sa to aj prostredníctvom Object Properties...

 

Zviditeľním zbernicu, je schovaná za tabuľkou, treba ju presunúť, a pridám na ňu

5.) ET-200S t.j.

PROFINET IO > I/O > ET 200S > IM151-3 PN HF V7.0 

 

Po výbere teda premiestnim ET-200S na zbernicu,

po premiestnení na zbernicu rozkliknem a  

Device name premenujem na AB10, zmením aj Device number (po dvojkliku na ikonku) na 3  a potvrdím OK

Rozkliknem vybrané IM151-3 PN HF V7.0 a vyberiem karty:

1-krát PM > PM-E DC24V = 6ES7 138 - 4CA01 0AA0 (číslo karty je napísané jej dolnej časti),

 Copyright © 2013 - 2025 Encyklopédia poznania 3/11



5-krát DI  > 8DI DC24V = 6ES7 131- 4BF00 0AA0 (číslo karty je napísané v jej dolnej časti),

5-krát DO > 8DO DC24V/0,5A = 6ES7 132 - 4BF00 0AA0 (číslo karty je napísané v jej dolnej časti),

1-krát AI > 2AI U ST = 6ES7 134 - 4FB01 0AB0 (číslo karty je napísané v jej dolnej časti).

K dispozícií je 12 vstupno/výstupných kariet. 

 Obrazovka PC po vložení vstupno/výstupných kariet, rozkliknutá ikona ET 200S (AB10)

Kliknite na zbernicu Ethernet (1)

 

6.) SCALANCE X208 t.j.

PROFINET IO > Network Components > SCALANCE X-200 > SCALANCE X208 > 6GK5 208-0BA10-2AA3 > SCALANCE X208
V5.0    

Po výbere teda premiestnim SCALANCE na zbernicu,

po premiestnení na zbernicu rozkliknem a  

Device name premenujem na AB04, zmením aj Device number na 4 a potvrdím OK
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 Rozkliknutá ikona SCALANCE X-200 (AB04)

 

V ikonách hlavného menu vyberiem a kliknem na:

Save a Compile

 
(53) Ikonka uloženia a kompilácie konfigurácie

Po kliknutí do SIMATIC Manager uvidím zmenu resp. k ikone Hardware pribudnú ikony CPU 315 a CP
343-1.

potom v okne HW config - SIMATIC 300, do ktorého sa prepneme v dolnej časti obrazovky, klikneme na ikonku

Download to module 

 
(54) Ikonka Download to module

A klik na OK
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Asi po minúte sa zjaví karta na ktorej kliknem na View, opäť chvíľku čakám, a následne vyberiem S7-300

Výber potvrdím Ok dvakrát

Kliknem na zbernicu a potom do menu

PLC > Ethernet > Assign Device Name

následne v roletovom menu pre

AB02 priradím (klik na Assign Name ) CPU 315 (rozblikaním môžete preveriť. Pozor, nemusí sa nachádzať v zozname -
viď obrázok nižšie). 

AB03  priradím (klik na  Assign Name )  CPU 343-1 (rozblikaním môžete preveriť.  Pozor,  nemusí  sa nachádzať v
zozname - viď obrázok nižšie).

AB04 priradím (klik na Assign Name) SCALANCE X-200 (rozblikaním môžete preveriť)

AB10 priradím (klik na Assign Name) ET 200S (rozblikaním môžete preveriť)

Potom kliknem na Update a všetky získajú IP adresu.

Získané IP adresy

 

Po zavretí okna a kliku na ikonu Online v SIMATIC Manageri viem preveriť správnosť realizácie HW-konfigurácie.
Všetky 3 krabičky (CPU, CP a ET200S) na štande svietia zeleno.

 
obr. 55 Ikonka Online
Na štande prepnem tlačidlo na RUN.

Prepnem sa na ikonku Offline (ikonka v hlavnom menu).

 
obr. 56 Ikonka Offline
V HW Config SIMATIC 300 kliknem na obrázok (ikonku) ET 200S (AB10).

Musím premenovať absolútne adresy DI a DO.

Pôvodné DI

0.0..0.7 ostáva

1.0..1.7 ostáva

2.0..2.7 ostáva

3.0..3.7 ostáva

4.0..4.7 mením na 8.0..8.7 ľavým dvojklikom. Potom prepnúť na záložku Addresses.

Premenuvávam od posledného k prvému! 

Pôvodné DO: 
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mením na 8.0..8.7, 

mením na 7.0..7.7, 

mením na 6.0..6.7,

mením na 5.0..5.7, 

mením na 4.0..4.7. 

Celkovo vykonám spolu 6 zmien absolútnych adries.

V ikonách hlavného menu opäť vyberiem a kliknem na:

Save a Compile

potom

Download to module

a OK niekoľkokrát resp. 4krát.

Po ukončení HW-konfigurácie sa prepínam do okna môjho projektu

a otvorím všetky možnosti, t.j. celú stromovú štruktúru aj detaily.

Klikám na Blocks v CPU315F…

Do zložky Blocks vložím Inser New Object  > Variable Table a klik na Ok

Variable Table otvorím dvojklikom alebo cez Open Object. 

V okne VAT_1 kliknem na Options > Symbole Table.

Do stĺpca Address v okne Symbol Table vložím postupne:

I 0.0  nápis BOOL sa zjaví automaticky po Enter

I 0.1 BOOL

I 0.2 BOOL

I 0.3 BOOL

I 0.4 BOOL

I 0.5 BOOL

I 0.6 BOOL

I 0.7 BOOL

I 1.0 BOOL

I 1.1 BOOL

I 1.2 BOOL

I 1.3 BOOL

I 1.4 BOOL

I 1.5 BOOL

I 1.6 BOOL

I 1.7 BOOL

I 2.0 BOOL

I 2.1 BOOL

I 2.2 BOOL

I 2.3 BOOL
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I 2.4 BOOL

I 2.5 BOOL

I 2.6 BOOL

I 2.7 BOOL

I 3.0 BOOL

I 3.1 BOOL

I 3.2 BOOL

I 3.3 BOOL

I 3.4 BOOL

I 3.5 BOOL

I 3.6 BOOL

I 3.7 BOOL

IW 2 WORD sa zjaví automaticky po Enter

Q 4.0 BOOL

Q 4.1 BOOL

Q 4.2 BOOL

Q 4.3 BOOL

Q 4.4 BOOL

Q 4.5 BOOL

Q 4.6 BOOL

Q 4.7 BOOL

Q 5.0 BOOL

Q 5.1 BOOL

Q 5.2 BOOL

Q 5.3 BOOL

Q 5.4 BOOL

Q 5.5 BOOL

Q 5.6 BOOL

Q 5.7 BOOL

Q 8.0 BOOL

Q 8.1 BOOL

Q 8.2 BOOL

Q 8.3 BOOL

Q 8.4 BOOL

Q 8.5 BOOL

Q 8.6 BOOL

Q 8.7 BOOL

QW 6 WORD sa zjaví automaticky po Enter
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Zo Symbol tabuľky nakopírujem údaje do VAR (VAT)  tabuľky.

Obdobným spôsobom ako v Exceli, t.j.

vo VAR (VAT) tabuľke zmažem všetky riadky,●

označím v Symbol tabuľke čo chcem kopírovať, t.j. bunky Address  a stlačím Ctrl + C,●

kliknem na VAR (VAT) tabuľku do stĺpca Address a stlačím Ctrl + V.●

V symbol tabuľke adresám priradím symbolické meno (Symbol). Vždy po doplnení jedného ukladám klikom na
ikonu diskety.

packa0h I 0.0 BOOL

packa1h I 0.1 BOOL

packa2h I 0.2 BOOL

packa3h I 0.3 BOOL

packa4h I 0.4 BOOL

packa5h I 0.5 BOOL

packa6h I 0.6 BOOL

packa7h I 0.7 BOOL

packa0d I 1.0 BOOL

packa1d I 1.1 BOOL

packa2d I 1.2 BOOL

packa3d I 1.3 BOOL

packa4d I 1.4 BOOL

packa5d I 1.5 BOOL

packa6d I 1.6 BOOL

packa7d I 1.7 BOOL

optozávora    I 8.0 BOOL

(stlačené) S1 I 8.1 BOOL

(stlačené) S2 I 8.2 BOOL

(stlačené) S3 I 8.3 BOOL

(stlačené) S4 I 8.4 BOOL

induksenzor1 I 8.5 BOOL

induksenzor2 I 8.6 BOOL

induksenzor3 I 8.7 BOOL

IW 2 WORD vstup čísla v 16 sústave (čierne tlačidlá)

(zelená) led0h Q 4.0 BOOL

led1h Q 4.1 BOOL

led2h Q 4.2 BOOL

led3h Q 4.3 BOOL

led4h Q 4.4 BOOL

led5h Q 4.5 BOOL

led6h Q 4.6 BOOL
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led7h Q 4.7 BOOL

led0d Q 5.0 BOOL

led1d Q 5.1 BOOL

led2d Q 5.2 BOOL

led3d Q 5.3 BOOL

led4d Q 5.4 BOOL

led5d Q 5.5 BOOL

led6d Q 5.6 BOOL

led7d Q 5.7 BOOL

Q 8.0 BOOL neobsadené

rozsvieth1 (žltú LED) Q 8.1 BOOL

rozsvieth2 Q 8.2 BOOL

rozsvieth3 Q 8.3 BOOL

rozsvieth4 Q 8.4 BOOL

pas>> Q 8.5 BOOL

pas<

sirena Q 8.7 BOOL

Zapnite si okuliare (Monitor), t.j. zobrazenie on-line kvôli sledovaniu stavu premenných.

QW 6 WORD výstup čísla v 16 sústave (4 červené 7-segmentovky).

Ak napríklad mením QW 6 (O t.j.)

najprv je potrebné modifikovať hodnotu (v stĺpci  Modify value)  vo VAR tabuľke vo formáte W#16#1111. V
desiatkovej sústave je to číslo 4369. 

Potom je potrebné aktivovať  (aktualizovať)  pôvodnú hodnotu na modifikovanú hodnotu príkazom Activate
Modify Value (F9).

Ak adresám priradzujem symbolické názvy, vždy musím kliknúť na Save v Tabuľke symbolov.

Obe, t.j. Variable Table a Symbole Table minimalizujem.

Prvé príkazy v LAD (KOP) budem vkladať do OB1

Klikám na preto na Blocks v CPU315F… teda robiť budem v PLC a vyberiem OB1

Potom rozkliknem Bit Logic

K dispozícii mám:

inštrukcie (príkazy) na zápis vľavo t.j. na začiatok,●

inštrukcie (príkazy) na zápis vpravo t.j. na koniec,●

inštrukcie (príkazy) na zápis medzi inštrukcie,●

inštrukcie (príkazy) na ovplyvnenie signálu.●

Po každom riadku t.j Networku, resp. zmene ukladám (Save) nahrávam do PLC (Download) a klikám na okuliare.
Nesmiem zabúdať okuliare (Monitor on/off) vypnúť.

V každom riadku programu, teda Networku vidím:

rank,●

inštrukcie,●

signál,●

adresy.●
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V menu View viem zmeniť spôsob zobrazenia (zápisu), resp. jazyk. T.j.:

LAD[5],●

STL[6],●

FBD. ●

[1] Ak neuvidím žiadnych účastníkov, pravdepodobne je odpojený sieťový (internetový) kábel od PG (zelený vzadu).
[2] Ponuka INSERT sa nachádza sa v hlavnom (hornom) menu.
[3] Rozkliknúť znamená 2-krát za sebou kliknúť ľavým tlačidlom myši na objekt.
[4] Tretí slot vynechávam.
[5] Inak KOP.
[6] Inak AWL.
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